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PROBLEM SOLVING USING R 

UNIT I 

What is the primary programming language used in R? 

a) Python 

b) Java 

c) R 

d) C++ 

 

Which of the following is a basic feature of R? 

a) Object-oriented programming 

b) Automatic memory management 

c) Multithreading support 

d) Static typing 

 

Which pane in the R console displays the results of executed commands? 

a) Console pane 

b) Editor pane 

c) Help pane 

d) Plot pane  

 

What is the purpose of comments in R code? 

a) To add explanations and documentation 

b) To disable a line of code temporarily 

c) To specify the data type of a variable 

d) To highlight syntax errors 



 

How can you install a package in R? 

a) Using the install.packages() function 

b) Using the load.packages() function 

c) Using the import.packages() function 

d) Using the require.packages() function  

 

Where can you find help files and function documentation in R? 

a) R website 

b) Package documentation 

c) RStudio IDE 

d) CRAN repository 

 

How can you save your work and exit R? 

a) Using the save() function 

b) Using the quit() function 

c) Using the exit() function 

d) Using the close() function 

 

Which of the following is a valid naming convention in R? 

a) variable-name 

b) VariableName 

c) variable_name 

d) 1variable  

 



 

Which mathematical operation is performed by the ^ operator in R? 

a) Addition 

b) Subtraction 

c) Multiplication 

d) Exponentiation 

 

What does the function log10() compute in R? 

a) Natural logarithm 

b) Base 10 logarithm 

c) Exponential function 

d) Square root 

 

How can you assign a value to an object in R? 

a) Using the = operator 

b) Using the <- operator 

c) Using the -> operator 

d) Using the == operator  

 

What is the data structure used to store multiple values of the same type in R? 

a) Array 

b) List 

c) Data frame 

d) Vector 

 



How can you create a vector in R? 

a) Using the c() function 

b) Using the vector() function 

c) Using the list() function 

d) Using the array() function 

 

Which function is used to generate sequences of numbers in R? 

a) seq() 

b) rep() 

c) sort() 

d) length() 

 

What is the characteristic of vector-oriented behavior in R? 

a) Operations are applied element-wise 

b) Operations are applied to the entire vector 

c) Operations can only be applied to numeric vectors 

d) Operations require explicit loops for processing 

 

Answers 

1. c) R 

 

2. b) Automatic memory management 

 

3. a) Console pane 

 



4. a) To add explanations and documentation 

 

5. a) Using the install.packages() function 

 

6. b) Package documentation 

 

7. b) Using the quit() function 

 

8. b) VariableName 

 

9. d) Exponentiation 

 

10. b) Base 10 logarithm 

 

11. b) Using the <- operator 

 

12. d) Vector 

 

13. a) Using the c() function 

 

14. a) seq() 

 

15. a) Operations are applied element-wise 

 

 



1. Which function is used to check the documentation and examples for a specific R function? 

   a) help() 

   b) doc() 

   c) info() 

   d) man() 

 

2. How can you create a new R script file in RStudio? 

   a) File -> New Script 

   b) Edit -> New Script 

   c) Tools -> New Script 

   d) View -> New Script 

 

3. What is the purpose of the command `sessionInfo()` in R? 

   a) Displays information about the current R session 

   b) Retrieves information from an external data source 

   c) Prints the contents of a data frame 

   d) Checks for errors and warnings in the code 

 

4. How can you check the current working directory in R? 

   a) dir() 

   b) pwd() 

   c) getwd() 

   d) cwd()  

 

 



5. Which function is used to remove an object from the R workspace? 

   a) remove() 

   b) delete() 

   c) clear() 

   d) unload() 

 

6. What is the purpose of the function `length()` in R? 

   a) Returns the number of rows in a data frame 

   b) Calculates the length of a vector or list 

   c) Computes the sum of all elements in a vector 

   d) Finds the maximum value in a numeric vector 

 

7. Which of the following is an example of a logical operator in R? 

   a) %in% 

   b) <- 

   c) && 

   d) ~ 

 

8. What is the default behavior of the assignment operator in R? 

   a) Overwrites the existing object with the new value 

   b) Appends the new value to the existing object 

   c) Creates a new object with the assigned value 

   d) Throws an error if the object already exists 

  

 



9. How can you concatenate two vectors in R? 

   a) Using the + operator 

   b) Using the append() function 

   c) Using the merge() function 

   d) Using the c() function 

 

10. Which function is used to sort a vector in ascending order in R? 

    a) sort() 

    b) order() 

    c) rank() 

    d) arrange() 

 

11. What is the purpose of the function `head()` in R? 

    a) Returns the first few rows of a data frame or matrix 

    b) Calculates the mean of a numeric vector 

    c) Extracts a subset of elements from a vector 

    d) Checks if a value is present in a vector 

 

12. Which function is used to extract a specific element from a vector in R? 

    a) subset() 

    b) extract() 

    c) slice() 

    d) [] 

  

 



13. What is the result of the expression `3:8` in R? 

    a) 3, 4, 5, 6, 7, 8 

    b) 3, 5, 7 

    c) 8, 7, 6, 5, 4, 3 

    d) 3.8 

 

14. Which function is used to calculate the mean of a numeric vector in R? 

    a) mean() 

    b) sum() 

    c) median() 

    d) var() 

 

15. What is the purpose of the function `rep()` in R? 

    a) Replicates elements in a vector or list 

    b) Replaces missing values with a specified value 

    c) Reorders the elements of a vector 

    d) Removes duplicate elements from a vector  

 

Answers 

 

1. a) help() 

 

2. a) File -> New Script 

 

3. a) Displays information about the current R session 



 

4. c) getwd() 

 

5. a) remove() 

 

6. b) Calculates the length of a vector or list 

 

7. c) && 

 

8. c) Creates a new object with the assigned value 

 

9. d) Using the c() function 

 

10. a) sort() 

 

11. a) Returns the first few rows of a data frame or matrix 

 

12. d) [] 

 

13. a) 3, 4, 5, 6, 7, 8 

 

14. a) mean() 

 

15. a) Replicates elements in a vector or list 

 



UNIT II 

1. What is a matrix in R? 

   a) A one-dimensional array 

   b) A two-dimensional array 

   c) A collection of data frames 

   d) A statistical model 

 

2. How can you define a matrix in R using the matrix() function? 

   a) matrix(data) 

   b) matrix(data, nrow) 

   c) matrix(data, ncol) 

   d) matrix(data, nrow, ncol) 

 

3. Which argument in the matrix() function determines the direction of filling the elements? 

   a) byrow 

   b) bycolumn 

   c) fill 

   d) direction 

 

4. How can you bind two matrices by rows in R? 

   a) bind_rows() 

   b) rbind() 

   c) row_bind() 

   d) merge() 

 



5. What does the dim() function return in R? 

   a) Number of rows in a matrix 

   b) Number of columns in a matrix 

   c) Dimensions of a matrix 

   d) Data type of a matrix 

 

6. How can you subset a specific row in a matrix in R? 

   a) matrix[row, ] 

   b) matrix[, row] 

   c) matrix[row] 

   d) matrix[row, col] 

 

7. How can you extract a specific column from a matrix in R? 

   a) matrix[row, ] 

   b) matrix[, col] 

   c) matrix[col] 

   d) matrix[row, col] 

 

8. How can you extract the main diagonal elements of a matrix in R? 

   a) diag(matrix) 

   b) main_diag(matrix) 

   c) matrix[diag] 

   d) matrix[main_diag] 

 

 



9. What happens when you omit a dimension while defining a matrix in R? 

   a) R throws an error 

   b) R automatically assigns a value of 1 to the omitted dimension 

   c) R automatically assigns a value of 0 to the omitted dimension 

   d) R automatically assigns a value of NA to the omitted dimension 

 

10. How can you perform matrix addition in R? 

    a) add() 

    b) plus() 

    c) matrix_add() 

    d) + 

 

11. How can you perform matrix multiplication in R? 

    a) multiply() 

    b) matmul() 

    c) matrix_mult() 

    d) %*% 

 

12. What is the result of multiplying a matrix by its inverse in R? 

    a) The identity matrix 

    b) A zero matrix 

    c) A matrix with all elements equal to 1 

    d) An empty matrix  

 

 



13. How can you transpose a matrix in R? 

    a) transpose() 

    b) transp() 

    c) matrix_transpose() 

    d) t() 

 

14. What is an identity matrix in R? 

    a) A matrix with all elements equal to 1 

    b) A matrix with all elements equal to 0 

    c) A matrix with ones on the main diagonal and zeros elsewhere 

    d) A matrix with zeros on the main diagonal and ones elsewhere 

 

15. How can you perform matrix subtraction in R? 

    a) subtract() 

    b) minus() 

    c) matrix_subtract() 

    d) - 

 

16. How can you create a multidimensional array in R? 

    a) array() 

    b) matrix() 

    c) list() 

    d) data.frame() 

 

 



17. How can you extract a subset of elements from a multidimensional array in R? 

    a) array_subset() 

    b) subset() 

    c) extract() 

    d) [] 

 

18. How can you replace specific elements in a matrix with new values in R? 

    a) replace() 

    b) modify() 

    c) assign() 

    d) [] 

 

19. What does the function rowMeans() do in R? 

    a) Calculates the mean of each row in a matrix 

    b) Calculates the mean of each column in a matrix 

    c) Calculates the sum of each row in a matrix 

    d) Calculates the sum of each column in a matrix 

 

20. How can you calculate the determinant of a matrix in R? 

    a) determinant() 

    b) det() 

    c) matrix_det() 

    d) diag()  

 

 



21. How can you calculate the inverse of a matrix in R? 

    a) inverse() 

    b) inv() 

    c) matrix_inv() 

    d) solve() 

 

22. How can you calculate the element-wise product of two matrices in R? 

    a) element_product() 

    b) mult() 

    c) matrix_mult() 

    d) * 

 

23. What does the function array() do in R? 

    a) Creates a matrix with predefined values 

    b) Creates a vector with predefined values 

    c) Creates a multidimensional array with predefined values 

    d) Creates a list with predefined values 

 

24. How can you extract a specific slice from a multidimensional array in R? 

    a) array_slice() 

    b) slice() 

    c) extract_slice() 

    d) [] 

 

 



25. How can you replace specific elements in a multidimensional array with new values in R? 

    a) replace() 

    b) modify() 

    c) assign() 

    d) [] 

 

26. How can you calculate the sum of all elements in a matrix in R? 

    a) sum(matrix) 

    b) total(matrix) 

    c) matrix_sum(matrix) 

    d) apply(matrix, sum) 

 

27. What is the result of dividing a matrix by its transpose in R? 

    a) A symmetric matrix 

    b) A diagonal matrix 

    c) A zero matrix 

    d) An identity matrix 

 

28. How can you calculate the cross product of two vectors in R? 

    a) cross_product() 

    b) prod() 

    c) matrix_prod() 

    d) cross() 

 

 



29. How can you find the maximum value in a matrix in R? 

    a) max(matrix) 

    b) maximum(matrix) 

    c) matrix_max(matrix) 

    d) apply(matrix, max) 

 

30. How can you calculate the sum of each column in a matrix in R? 

    a) colSums(matrix) 

    b) columnSums(matrix) 

    c) matrix_sum(matrix) 

    d) apply(matrix, sum, 2) 

 

Answers 

1. b) A two-dimensional array 

2. d) matrix(data, nrow, ncol)  

3. a) byrow 

4. b) rbind() 

5. c) Dimensions of a matrix 

6. a) matrix[row, ] 

7. b) matrix[, col] 

8. a) diag(matrix) 

9. b) R automatically assigns a value of 1 to the omitted dimension 

10. d) + 

11. d) %*% 

12. a) The identity matrix 



13. d) t() 

14. c) A matrix with ones on the main diagonal and zeros elsewhere 

15. d) - 

16. a) array() 

17. d) [] 

18. d) [] 

19. a) Calculates the mean of each row in a matrix 

20. b) det() 

21. d) solve() 

22. d) * 

23. c) Creates a multidimensional array with predefined values 

24. d) [] 

25. d) [] 

26. a) sum(matrix) 

27. a) A symmetric matrix 

28. d) cross() 

29. a) max(matrix) 

30. a) colSums(matrix) 

 

UNIT III 

1. In R, what values can logical variables have? 

   a) TRUE and FALSE 

   b) 0 and 1 

   c) Yes and No 

   d) On and Off 



 

2. Which operator is used to test for equality in R? 

   a) == 

   b) = 

   c) != 

   d) <= 

 

3. Which operator is used to test for inequality in R? 

   a) != 

   b) <> 

   c) ~= 

   d) > 

 

4. How can you create a character variable in R? 

   a) char() 

   b) create.character() 

   c) character() 

   d) string() 

 

5. How can you concatenate two strings in R? 

   a) concat() 

   b) merge() 

   c) str_c() 

   d) str_concat() 

 



6. What is the escape sequence for a newline character in R? 

   a) \n 

   b) \r 

   c) \t 

   d) \\ 

 

7. How can you extract a substring from a character variable in R? 

   a) substring() 

   b) extract() 

   c) str_extract() 

   d) [] 

 

8. What is a factor in R? 

   a) A categorical variable 

   b) A continuous variable 

   c) A binary variable 

   d) A numeric variable 

 

9. How can you convert a character variable to a factor in R? 

   a) as.factor() 

   b) convert.factor() 

   c) to_factor() 

   d) make_factor() 

 

 



10. How can you identify the unique categories in a factor variable in R? 

    a) unique() 

    b) distinct() 

    c) levels() 

    d) categories() 

 

11. How can you define and order levels in a factor variable in R? 

    a) factor_order() 

    b) order_levels() 

    c) reorder() 

    d) levels_order() 

 

12. How can you combine two factor variables in R? 

    a) combine() 

    b) merge() 

    c) factor_combine() 

    d) c() 

 

13. How can you cut a numeric variable into discrete intervals in R? 

    a) cut() 

    b) divide() 

    c) bin() 

    d) slice()  

 

 



14. What is the purpose of the function levels() in R? 

    a) Returns the categories of a factor variable 

    b) Returns the levels of a numeric variable 

    c) Returns the unique values of a character variable 

    d) Returns the order of levels in a factor variable 

 

15. How can you check if two character variables are equal in R? 

    a) equals() 

    b) identical() 

    c) == 

    d) compare() 

 

16. What does the function nchar() do in R? 

    a) Returns the number of characters in a string 

    b) Returns the number of elements in a vector 

    c) Returns the number of levels in a factor variable 

    d) Returns the number of rows in a data frame 

 

17. How can you convert a character variable to uppercase in R? 

    a) to_upper() 

    b) upper() 

    c) str_to_upper() 

    d) toupper()  

 

 



18. How can you find the position of a substring within a character variable in R? 

    a) str_pos() 

    b) find_pos() 

    c) str_locate() 

    d) position() 

 

19. How can you convert a factor variable to a character variable in R? 

    a) as.character() 

    b) convert.character() 

    c) to_character() 

    d) make_character()  

 

20. What is the purpose of the function paste() in R? 

    a) Concatenates strings 

    b) Converts a factor variable to character representation 

    c) Reorders the levels of a factor variable 

    d) Cuts a numeric variable into intervals 

 

21. How can you test if a value is present in a character vector in R? 

    a) is_present() 

    b) in_vector() 

    c) %in% 

    d) check() 

 

 



22. How can you replace specific elements in a character vector with new values in R? 

    a) replace() 

    b) modify() 

    c) assign() 

    d) [] 

 

23. What does the function grepl() do in R? 

    a) Checks if a pattern matches a string 

    b) Searches for a substring in a string 

    c) Returns the number of occurrences of a pattern in a string 

    d) Converts a logical vector to a character vector 

 

24. How can you count the occurrences of a specific character in a character variable in R? 

    a) count_chars() 

    b) char_count() 

    c) str_count() 

    d) count() 

 

25. How can you convert a character variable to lowercase in R? 

    a) to_lower() 

    b) lower() 

    c) str_to_lower() 

    d) tolower()  

 

 



26. What is the purpose of the function strsplit() in R? 

    a) Splits a string into substrings based on a specified delimiter 

    b) Searches for a pattern in a string and replaces it with a new value 

    c) Converts a character vector to a factor variable 

    d) Returns the position of a substring within a string 

 

27. How can you extract the first n characters from a character variable in R? 

    a) str_extract() 

    b) substr() 

    c) extract_chars() 

    d) [] 

 

28. How can you check if a string starts with a specific substring in R? 

    a) starts_with() 

    b) str_starts() 

    c) substr() 

    d) str_detect() 

 

29. What is the purpose of the function toupper() in R? 

    a) Converts a character variable to uppercase 

    b) Converts a numeric variable to uppercase 

    c) Returns the total number of uppercase characters in a string 

    d) Returns the position of the first uppercase character in a string 

 

 



30. How can you extract a specific range of characters from a character variable in R? 

    a) str_extract() 

    b) substr() 

    c) extract_chars() 

    d) [] 

 

Answers 

1. a) TRUE and FALSE 

2. a) == 

3. a) != 

4. c) character() 

5. c) str_c() 

6. a) \n 

7. a) substring() 

8. a) A categorical variable 

9. a) as.factor() 

10. c) levels() 

11. c) reorder() 

12. d) c() 

13. a) cut() 

14. a) Returns the categories of a factor variable 

15. c) == 

16. a) Returns the number of characters in a string 

17. d) toupper() 

18. c) str_locate() 



19. a) as.character() 

20. a) Concatenates strings 

21. c) %in% 

22. d) [] 

23. a) Checks if a pattern matches a string 

24. c) str_count() 

25. d) tolower() 

26. a) Splits a string into substrings based on a specified delimiter 

27. b) substr() 

28. a) starts_with() 

29. a) Converts a character variable to uppercase 

30. b) substr() 

 

UNIT IV 

1. In R, which data structure allows you to store objects of different types together? 

   a) Vectors 

   b) Matrices 

   c) Lists 

   d) Data frames 

 

2. How can you access a specific component within a list in R? 

   a) list$component_name 

   b) list[component_name] 

   c) list[[component_name]] 

   d) list@component_name 



 

3. How can you assign a name to an object in R? 

   a) object_name <- "name" 

   b) name(object_name) <- "name" 

   c) assign(object_name, "name") 

   d) names(object_name) <- "name" 

 

4. What is nesting in the context of lists in R? 

   a) Storing multiple lists within a single list 

   b) Storing vectors within a list 

   c) Storing matrices within a list 

   d) Storing data frames within a list 

 

5. What is a data frame in R? 

   a) A structure for storing numeric data 

   b) A structure for storing character data 

   c) A structure for storing lists 

   d) A structure for storing tabular data 

 

6. How can you add a new data column to an existing data frame in R? 

   a) df$new_column <- values 

   b) df$add_column(new_column, values) 

   c) df <- add_column(df, new_column, values) 

   d) add_column(df, new_column, values) 

 



7. How can you combine two data frames by row in R? 

   a) row_combine(df1, df2) 

   b) rbind(df1, df2) 

   c) combine_rows(df1, df2) 

   d) bind_rows(df1, df2) 

 

8. How can you create a logical subset of a data frame in R based on a condition? 

   a) subset(df, condition) 

   b) filter(df, condition) 

   c) select(df, condition) 

   d) logical_subset(df, condition) 

 

9. What special value in R represents infinity? 

   a) Inf 

   b) -Inf 

   c) NaN 

   d) NA 

 

10. What special value in R represents undefined or missing values? 

    a) Inf 

    b) -Inf 

    c) NaN 

    d) NA  

 

 



11. What special value in R represents a missing value? 

    a) Inf 

    b) -Inf 

    c) NaN 

    d) NA 

 

12. What is an attribute in R? 

    a) Additional metadata associated with an object 

    b) A mathematical property of an object 

    c) A specific value within an object 

    d) A sub-component of an object  

 

13. How can you check the class of an object in R? 

    a) class(obj) 

    b) typeof(obj) 

    c) typeof_class(obj) 

    d) obj.class() 

 

14. What does the "is" function in R do? 

    a) Checks if an object is equal to another object 

    b) Checks if an object is of a specific class 

    c) Checks if an object is NULL 

    d) Checks if an object is a factor  

 

 



15. What does the dot object represent in R? 

    a) The current working directory 

    b) The last executed command 

    c) The missing value placeholder 

    d) The output of the previous function 

 

16. How can you check if an object is a function in R? 

    a) is.function(obj) 

    b) is.func(obj) 

    c) typeof(obj) == "function" 

    d) obj.is_function() 

 

17. How can you perform argument checking within a function in R? 

    a) check_args() 

    b) verify_args() 

    c) assert_args() 

    d) stopifnot() 

 

18. What does the as.character() function do in R? 

    a) Converts an object to a character vector 

    b) Converts an object to a numeric vector 

    c) Converts an object to a factor 

    d) Converts an object to a logical vector  

 

 



19. How can you check if an object is NULL in R? 

    a) is.null(obj) 

    b) obj == NULL 

    c) obj.is_null() 

    d) typeof(obj) == "NULL" 

 

20. What does the as.numeric() function do in R? 

    a) Converts an object to a numeric vector 

    b) Converts an object to a character vector 

    c) Converts an object to a factor 

    d) Converts an object to a logical vector 

 

21. How can you convert a numeric vector to a factor in R? 

    a) as.factor() 

    b) convert_factor() 

    c) to_factor() 

    d) make_factor() 

 

22. What does the as.logical() function do in R? 

    a) Converts an object to a logical vector 

    b) Converts an object to a numeric vector 

    c) Converts an object to a character vector 

    d) Converts an object to a factor 

 

 



23. How can you check if an object is numeric in R? 

    a) is.numeric(obj) 

    b) obj.is_numeric() 

    c) typeof(obj) == "numeric" 

    d) is.num(obj) 

 

24. How can you check if an object is a data frame in R? 

    a) is.dataframe(obj) 

    b) obj.is_dataframe() 

    c) typeof(obj) == "data.frame" 

    d) is.frame(obj) 

 

25. How can you convert a factor to a character vector in R? 

    a) as.character() 

    b) convert_character() 

    c) to_character() 

    d) make_character() 

 

26. What does the attributes() function do in R? 

    a) Returns the attributes of an object 

    b) Sets new attributes for an object 

    c) Deletes attributes from an object 

    d) Checks if an object has attributes  

 

 



27. How can you check if an object is a character vector in R? 

    a) is.character(obj) 

    b) obj.is_character() 

    c) typeof(obj) == "character" 

    d) is.char(obj) 

 

28. What does the as.factor() function do in R? 

    a) Converts an object to a factor 

    b) Converts an object to a numeric vector 

    c) Converts an object to a character vector 

    d) Converts an object to a function  

 

29. How can you check if an object is a factor in R? 

    a) is.factor(obj) 

    b) obj.is_factor() 

    c) typeof(obj) == "factor" 

    d) is.fact(obj) 

 

30. How can you coerce an object to a specific class in R? 

    a) coerce_class() 

    b) as.class() 

    c) to_class() 

    d) class(obj) <- "class" 

 

 



Answers 

 

1. c) Lists 

2. c) list[[component_name]] 

3. b) name(object_name) <- "name" 

4. a) Storing multiple lists within a single list 

5. d) A structure for storing tabular data 

6. a) df$new_column <- values 

7. d) bind_rows(df1, df2) 

8. b) filter(df, condition) 

9. a) Inf 

10. d) NA 

11. d) NA 

12. a) Additional metadata associated with an object 

13. a) class(obj) 

14. b) Checks if an object is of a specific class 

15. c) The missing value placeholder 

16. a) is.function(obj) 

17. d) stopifnot() 

18. a) Converts an object to a character vector 

19. a) is.null(obj) 

20. a) Converts an object to a numeric vector 

21. a) as.factor() 

22. a) Converts an object to a logical vector 

23. a) is.numeric(obj) 



24. a) is.dataframe(obj) 

25. a) as.character() 

26. a) Returns the attributes of an object 

27. a) is.character(obj) 

28. a) Converts an object to a factor 

29. a) is.factor(obj) 

30. b) as.class() 

  

 

UNIT V 

1. In R, which function is used to create a basic plot with coordinate vectors? 

   a) plot() 

   b) barplot() 

   c) hist() 

   d) boxplot() 

 

2. How can you customize the appearance of a plot in R? 

   a) Using graphical parameters 

   b) Using color palettes 

   c) Using plot types 

   d) Using data sets  

 

 

 

 



3. What is the purpose of a title in a plot? 

   a) To label the x-axis 

   b) To label the y-axis 

   c) To provide a description of the plot 

   d) To add colors to the plot 

 

4. How can you add axis labels to a plot in R? 

   a) Using the xlabel() and ylabel() functions 

   b) Using the title() function 

   c) Using the text() function 

   d) Using the legend() function 

 

5. How can you change the color of lines in a plot in R? 

   a) Using the col parameter in the plot() function 

   b) Using the pch parameter in the plot() function 

   c) Using the col parameter in the lines() function 

   d) Using the pch parameter in the lines() function 

 

6. How can you change the appearance of points in a plot in R? 

   a) Using the pch parameter in the plot() function 

   b) Using the col parameter in the plot() function 

   c) Using the pch parameter in the points() function 

   d) Using the col parameter in the points() function  

 

 



7. How can you set the limits of the plotting region in R? 

   a) Using the xlim() and ylim() functions 

   b) Using the axis() function 

   c) Using the par() function 

   d) Using the plot() function 

 

8. How can you add points, lines, and text to an existing plot in R? 

   a) Using the points(), lines(), and text() functions 

   b) Using the add_points(), add_lines(), and add_text() functions 

   c) Using the par() function 

   d) Using the plot() function 

 

9. Which package in R is commonly used for advanced plotting and visualization? 

   a) ggplot2 

   b) base 

   c) lattice 

   d) plyr 

 

10. How can you create a quick plot using the ggplot2 package in R? 

    a) Using the plot() function 

    b) Using the qplot() function 

    c) Using the geom_plot() function 

    d) Using the ggplot() function 

 

 



11. How can you set appearance constants with geoms in ggplot2? 

    a) Using the size parameter 

    b) Using the color parameter 

    c) Using the shape parameter 

    d) Using the fill parameter 

 

12. How can you read a file into R? 

    a) read_file() 

    b) load_data() 

    c) import_data() 

    d) read.table() 

 

13. What are R-ready data sets? 

    a) Data sets provided with the R software 

    b) Data sets created by R users and shared online 

    c) Data sets that require additional processing before use in R 

    d) Data sets used exclusively by the ggplot2 package 

 

14. What is the purpose of contributed data sets in R? 

    a) To provide additional examples for learning R 

    b) To test the functionality of R packages 

    c) To evaluate the performance of R functions 

    d) To improve the documentation of R functions  

 

 



15. How can you read in external data files in R? 

    a) read.csv() 

    b) import_data() 

    c) load_data() 

    d) read.file() 

 

16. How can you write out data files in R? 

    a) write.csv() 

    b) export_data() 

    c) save_data() 

    d) write.file() 

 

17. How can you write out plots as image files in R? 

    a) save_plot() 

    b) export_plot() 

    c) write_plot() 

    d) ggsave() 

 

18. How can you perform ad hoc object read/write operations in R? 

    a) save() 

    b) load() 

    c) write() 

    d) read() 

 

 



19. Which function in R is commonly used to read in CSV files? 

    a) read.csv() 

    b) read.table() 

    c) read.delim() 

    d) read.xlsx() 

 

20. Which function is used to read in Excel files in R? 

    a) read.xlsx() 

    b) read.csv() 

    c) read.table() 

    d) read.delim() 

 

21. How can you read in a tab-delimited file in R? 

    a) read.table() 

    b) read.csv() 

    c) read.delim() 

    d) read.xlsx() 

 

22. What is the purpose of the write.csv() function in R? 

    a) To write data frames to a CSV file 

    b) To write plots to a CSV file 

    c) To write vectors to a CSV file 

    d) To write functions to a CSV file  

 

 



23. What does the readRDS() function do in R? 

    a) Reads a saved R workspace 

    b) Reads an R data file 

    c) Reads an R package 

    d) Reads an R script 

 

24. How can you write a data frame to an Excel file in R? 

    a) write.xlsx() 

    b) write.csv() 

    c) write.table() 

    d) write.delim() 

 

25. How can you save an R object to a file for later use? 

    a) save() 

    b) write() 

    c) export() 

    d) saveRDS() 

 

26. How can you load a saved R object from a file? 

    a) load() 

    b) read() 

    c) import() 

    d) readRDS() 

 

 



27. What is the purpose of the saveRDS() function in R? 

    a) To save an R object as a serialized file 

    b) To save a data frame as an RDS file 

    c) To save a plot as an RDS file 

    d) To save a function as an RDS file 

 

28. How can you read in a JSON file in R? 

    a) json_read() 

    b) read.json() 

    c) jsonlite::fromJSON() 

    d) json_parse() 

 

29. What does the writeLines() function do in R? 

    a) Writes character strings to a file 

    b) Writes numeric vectors to a file 

    c) Writes data frames to a file 

    d) Writes plots to a file 

 

30. How can you export a plot to a PDF file in R? 

    a) pdf() 

    b) export_pdf() 

    c) save_pdf() 

    d) ggsave() 

 

 



Answers 

1. a) plot() 

2. a) Using graphical parameters 

3. c) To provide a description of the plot 

4. a) Using the xlabel() and ylabel() functions 

5. c) Using the col parameter in the lines() function 

6. c) Using the pch parameter in the points() function 

7. a) Using the xlim() and ylim() functions 

8. a) Using the points(), lines(), and text() functions 

9. a) ggplot2 

10. b) Using the qplot() function 

11. d) Using the fill parameter 

12. d) read.table() 

13. b) Data sets created by R users and shared online 

14. a) To provide additional examples for learning R 

15. a) read.csv() 

16. a) write.csv() 

17. d) ggsave() 

18. b) load() 

19. a) read.csv() 

20. a) read.xlsx() 

21. c) read.delim() 

22. a) To write data frames to a CSV file 

23. a) Reads a saved R workspace 

24. a) write.xlsx() 



25. a) save() 

26. a) load() 

27. a) To save an R object as a serialized file 

28. c) jsonlite::fromJSON() 

29. a) Writes character strings to a file 

30. d) ggsave() 

 

**************************** 
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